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SUMMARY: 33 
The derivation of a flavonol is crucial for its application in healthcare and the food industry. 34 
Here, we provide a detailed protocol for the biosynthesis of a flavonol from a flavanone and 35 
discuss the crucial steps and its advantages over other approaches. 36 
 37 
ABSTRACT: 38 
Flavonols are a major subclass of flavonoids with a variety of biological and pharmacological 39 
activities. Here, we provide a method for the in vitro enzymatic synthesis of a flavonol. In this 40 
method, Atf3h and Atfls1, two key genes in the biosynthetic pathway of the flavonols, are 41 
cloned and overexpressed in Escherichia coli. The recombinant enzymes are purified via an 42 
affinity column and then a bienzymatic cascade is established in a specific synthetic buffer. Two 43 
flavonols are synthesized in this system as examples and determined by TLC and HPLC/LC/MS 44 
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analyses. The method displays obvious advantages in the derivation of flavonols over other 45 
approaches. It is time- and labor-saving and highly cost-effective. The reaction is easy to be 46 
accurately controlled and thus scaled up for mass production. The target product can be 47 
purified easily due to the simple components in the system. However, this system is usually 48 
restricted to the production of a flavonol from a flavanone. 49 
 50 
INTRODUCTION: 51 
Flavonols are a major subclass of plant flavonoids and are involved in plant development and 52 
pigmentation1-3. More importantly, these compounds possess a wide range of health-beneficial 53 
activities, such as anti-cancer4,5, anti-oxidative6, anti-inflammatory7, antiobesity8, anti-54 
hypertensive9, and memory recall properties10, leading to a large number of studies on these 55 
plant-derived secondary metabolites. Traditionally, these compounds are mainly derived from 56 
plant extraction using organic solvents. However, due to their very low contents in plants11-13, 57 
the production cost for most flavonols remains high, which imposes great restrictions on their 58 
application in healthcare and the food industry. 59 
 60 
During the past decades, scientists have developed quite a number of methods to derive 61 
flavonoids14,15. However, chemical synthesis of these complicated molecules possesses a variety 62 
of intrinsic disadvantages16. It requires not only toxic reagents and extreme reaction conditions, 63 
but also many steps to produce a target flavonoid compound14,17. Moreover, another important 64 
challenge in this strategy is the chiral synthesis of active flavonoid molecules. Therefore, it is 65 
not an ideal strategy to produce flavonoids at a commercial scale via chemical synthesis16,17. 66 
 67 
Recently, scientists have developed a promising alternative strategy to produce these 68 
complicated natural compounds by engineering microbes with a pathway for flavonoid 69 
biosynthesis18-22, which has been successfully deciphered in plants23. For example, Duan et al. 70 
introduced a biosynthetic pathway into the budding yeast Saccharomyces cerevisiae to produce 71 
kaempferol (KMF)24. Malla et al. produced astragalin, a glycosylated flavonol, by introducing 72 
flavanone 3-hydroxylase (f3h), flavonol synthase (fls1), and UDP-glucose:flavonoid 3-O-73 
glucosyltransferase UGT78K1 genes into Escherichia coli BL21(DE3)17. Even though there are 74 
quite a few paradigms, not all genetically engineered microbes produce the products of interest 75 
due to the complexity of a cellular platform, the incompatibility between artificially synthesized 76 
genetic elements and hosts, the inhibitory effect of target products against host cells, and the 77 
instability of an engineered cellular system itself16. 78 
 79 
Another promising alternative strategy for flavonoid production is to establish a multienzymatic 80 
cascade in vitro. Cheng et al. have reported that enterocin polyketides can be successfully 81 
synthesized by assembling a complete enzymatic pathway in one pot25. This cell-free synthetic 82 
strategy circumvents the restrictions of a microbial production factory and thus is feasible for 83 
producing some flavonoids in large quantity16. 84 
 85 
Recently, we have successfully developed a bienzyme synthetic system to convert naringenin 86 
(NRN) into KMF in one pot16. Here, we describe this system in great details and the methods 87 
involved in analyzing the products. We also present two examples that use this system to 88 
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produce KMF from NRN and quercetin (QRC) from eriodictyol (ERD). In addition, we discuss 89 
crucial steps of this method and future research directions in the biosynthesis of flavonoids. 90 
 91 
PROTOCOL: 92 
 93 
1. Isolate total RNA from plant tissues26,27 94 
 95 
1.1) Homogenize the plant tissues. 96 
 97 
1.1.1) Collect 100 mg of a fresh plant tissue (e.g., 4-week-old seedlings from Arabidopsis 98 
thaliana). Freeze the tissue and a pestle and mortar with liquid nitrogen, followed by grinding 99 
the tissue into powder. 100 
 101 
1.1.2) Add 1 mL of RNA isolation reagent (see Table of Materials) into the mortar. The reagent 102 
will be frozen immediately. Homogenize the tissue sample with the pestle when the frozen 103 
reagent melts. 104 
 105 
1.1.3) Transfer the homogenate to a 1.5-mL tube, centrifuge the sample at 12,000 x g for 5 min 106 
at 4 °C, and then transfer the cleared homogenate solution to another fresh 1.5-mL tube. 107 
 108 
1.1.4) Incubate the homogenized sample at room temperature for 5 min. 109 
 110 
1.2) Isolate total RNA. 111 
 112 
1.2.1) Add 0.2 mL of chloroform to the homogenate, cap the tube securely, shake the tube 113 
vigorously by hand for 15 s, and incubate the sample at room temperature for 5 min. 114 
 115 
1.2.2) Centrifuge the sample at 12,000 x g for 15 min at 4 °C and transfer the colorless upper 116 
aqueous phase to a fresh 1.5-mL tube. The sample separates into three phases following 117 
centrifugation. 118 
 119 
1.2.3) Add 0.5 mL of isopropyl alcohol to the aqueous phase, shake the tube by hand in a 120 
vigorous manner, and incubate the mixture at room temperature for 10 min. 121 
 122 
1.2.4) Centrifuge the mixture at 12,000 x g for 10 min at 4 °C and remove the supernatant. 123 
 124 
1.2.5) Wash the RNA pellet once with 1 mL of 75% ethanol by vortexing, followed by 125 
centrifugation at 7,500 x g for 5 min at 4 °C. 126 
 127 
1.2.6) Repeat step 1.2.5. 128 
 129 
1.2.7) Air dry the pellet for 5-10 minutes and redissolve the RNA in diethylpyrocarbonate 130 
(DEPC)-treated water by pipetting up and down, followed by measuring the total RNA 131 
concentration with a micro-spectrophotometer (see Table of Materials). 132 
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 133 
2. Synthesize complementary DNA (cDNA)28 134 
 135 
2.1) Synthesize the first strand of cDNA using a kit (see Table of Materials). Set up a 20-μL 136 
reaction system as shown in Table 1 and incubate the reaction tube in a PCR instrument for 50 137 
min at 42 °C, followed by terminating the reaction at 85 °C for 5 min. Store the reaction product 138 
at -20 °C for future amplification of genes. 139 
 140 
[Place Table 1 here] 141 
 142 
3. Construct recombinant plasmids29 143 
 144 
3.1) Design PCR primers. 145 
 146 
3.1.1) Design the PCR primers using a software (see Table of Materials) based on the sequences 147 
of key enzyme genes obtained from the GenBank database and synthesize the primers by a 148 
company (see Table of Materials). In the 5’ end of the primer, add a restriction enzyme site 149 
(e.g., BamHI or EcoRI in this protocol).  150 
 151 
NOTE: The primers used in this study are shown in Table 2. 152 
 153 
[Place Table 2 here] 154 
 155 
3.2) Clone the genes into a prokaryotic expression vector. 156 
 157 
3.2.1) Amplify the genes from the first strand of the synthesized cDNA using a high-fidelity DNA 158 
polymerase (see Table of Materials). Set up a 100-μL PCR reaction system as shown in Table 3 159 
and run the following PCR cycle: 94 °C for 2 min for initial denaturation;  then 35 cycles of 94 °C 160 
for 30 s for denaturation, 55 °C for 2 min for annealing, and 72 °C for 1 min for extension; 161 
followed by a final elongation at 72 °C for 10 min. Cool the reaction mixture to 12 °C.  162 
 163 
NOTE: The extension time is variable and determined by the gene length with polymerization of 164 
about 1000 bases per min for most DNA polymerases. 165 
 166 
[Place Table 3 here] 167 
 168 
3.2.2) Visualize the PCR products (most commonly 5 μL) on a 1% agarose gel and purify the 169 
specific DNA fragment from the remaining products using a DNA clean-up kit (see Table of 170 
Materials). 171 
 172 
3.2.3) Digest the purified DNA fragment and the vector (e.g., pET-32a(+)) with restriction 173 
enzymes (e.g., BamHI or EcoRI in this protocol). Set up a 50-μL reaction system in a 0.2 mL PCR 174 
tube as shown in Table 4 and incubate the mixture at 37 °C for 3 h. Separate the digested DNA 175 
on a 1% agarose gel. 176 
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 177 
[Place Table 4 here] 178 
 179 
3.2.4) Recover the DNA band using a gel extraction kit (see Table of Materials). Further purify 180 
the DNA using a DNA clean-up kit (see Table of Materials), followed by measuring the 181 
concentration of DNA with a micro-spectrophotometer (see Table of Materials). 182 
 183 
3.2.5) Ligate the gene fragment into the linearized vector DNA using a T4 DNA ligase (see Table 184 
of Materials). Set up a ligation reaction in a 1.5-mL tube as shown in Table 5 and incubate the 185 
tube at room temperature for 2 - 3 h.  186 
 187 
NOTE: The molar ratio of an insert to a vector is variable and ranged from 3:1 to 10:1. 188 
 189 
[Place Table 5 here] 190 
 191 
3.2.6) Add 2.5 μL of the ligation mixture into 50 μL of chemically competent Escherichia coli 192 
cells (e.g., TOP10 or DH5α), mix gently, and keep the tube on ice for 30 min. Heat shock the 193 
cells at 42 °C for 90 s and immediately place the tube on ice for 2 min.  194 
 195 
3.2.7) Add 200 μL of liquid LB medium without antibiotics into the tube and incubate the tube 196 
in a 37 °C shaker at 220 rpm for 1 h. Spread 50 - 100 μL of the cells on an LB plate containing 197 
100 μg/mL ampicillin and incubate at 37 °C overnight. 198 
 199 
3.3) Screen positive colonies. 200 
 201 
3.3.1) Inoculate a single colony from the LB plate into 200 μL of liquid LB medium containing 202 
100 μg/mL ampicillin and incubate at 37 °C, 250 rpm for 2 - 3 h.  203 
 204 
NOTE: In general, pick 4 - 8 colonies for screening positive colonies. 205 
 206 
3.3.2) Set up a 10-μL colony PCR reaction similar to that in step 3.2.1. 207 
 208 
NOTE: Use 1 μL of LB culture instead of 1 μL of cDNA template. 209 
 210 
3.3.3) Visualize the PCR products on a 1% agarose gel. Inoculate the remaining culture with a 211 
positive result into 3 mL of liquid LB medium containing 100 μg/mL ampicillin and incubate in a 212 
37 °C shaker at 250 rpm for 14 - 16 h. 213 
 214 
3.3.4) Isolate plasmid DNA from recombinant E. coli cultures using a plasmid miniprep kit (see 215 
Table of Materials). 216 
 217 
3.3.5) Identify the purified recombinant plasmids by a double restriction enzyme analysis (e.g., 218 
BamHI and EcoRI in this protocol). Set up a 10-μL reaction system similar to that in step 3.2.3, 219 
followed by incubation at 37 °C for 3 h. Visualize the specific band released from the 220 
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recombinant plasmid on a 1% agarose gel. 221 
 222 
3.4) Verify the sequences of positive recombinant plasmids. 223 
 224 
3.4.1) Send the plasmids to a company for sequencing. Analyze the results using a DNA 225 
sequence analysis software (see Table of Materials) by comparing the sequence obtained from 226 
the sequencing company with the reference sequence obtained from the GenBank database. 227 
 228 
4. Express recombinant enzyme proteins30 229 
 230 
4.1) Transform the correct recombinant plasmid into competent E. coli BL21(DE3). 231 
 232 
4.1.1) Add 0.1 μL of the plasmid to 10 μL of competent E. coli BL21(DE3) in a 1.5-mL tube on ice 233 
and keep the tube on ice for 5 min. 234 
 235 
4.1.2) Heat shock the cells in a 42 °C waterbath for 90 s and place it on ice again for 2 min. 236 
 237 
4.1.3) Add 200 μL of LB liquid medium without antibiotics and incubate in a 37 °C shaker at 220 238 
rpm for 5 min. 239 
 240 
4.1.4) Spread 50 μL of transformation on an LB agar plate containing 100 μg/mL ampicillin and 241 
incubate the plate overnight in a 37 °C incubator. 242 
 243 
4.2) Induce the expression of genes. 244 
 245 
4.2.1) Inoculate 3 - 5 colonies from the plate into a tube containing 3 mL of LB liquid medium 246 
with 100 μg/mL ampicillin and incubate at 250 rpm in a 37 °C shaker overnight. 247 
 248 
4.2.2) Transfer all of the overnight culture into 300 mL of LB liquid medium containing 100 249 
μg/mL ampicillin and incubate at 250 rpm in a 37 °C shaker until the optical density of the 250 
culture at 600 nm is between 0.4 - 0.6. 251 
 252 
4.2.3) Add isopropyl β-D-thiogalactoside (IPTG) into the culture with a final concentration of 0.2 253 
mM and induce the expression of the genes at 250 rpm, 20 - 22 °C for 3 h. 254 
 255 
5. Purify the recombinant enzyme proteins31 256 
 257 
5.1) Harvest the bacteria by centrifugation of the culture at 4 °C, 12,000 x g for 10 min. 258 
 259 
5.2) Resuspend the pellet in 15 mL of Bacterial Lysis Buffer containing 0.1% Triton X-100, 1 mM 260 
EDTA, 10% glycerol, 150 mM NaCl, 0.5 mM DTT, 0.1 mM PMSF, 1 μg/mL aprotinin, 1 μg/mL 261 
leupeptin, and 1 μg/mL pepstatin in 50 mM Tris-Cl (pH 8.0). 262 
 263 
5.3) Sonicate the bacterial suspension to release the recombinant enzyme proteins, followed by 264 
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centrifugation at 13,000 x g, 4 °C for 10 min. 265 
 266 
5.4) Harvest and aliquot the supernatant in 1.5-mL tubes at 1 mL/tube and store them at -70 °C 267 
for future use. 268 
 269 
5.5) Apply 500 μL of His-tag purification resin (see Table of Materials) to a reusable empty 270 
affinity column. Wash the resin with 5 bed volumes of deionized water to discard the ethanol in 271 
the stock solution. Balance the resin with 10 bed volumes of the binding buffer comprising Tris-272 
Cl (20 mM, pH 7.9), imidazole (10 mM), and NaCl (0.5 M). 273 
 274 
5.6) Apply 4 mL of the supernatant from Step 5.4 to a slurry of the above resin and block two 275 
ends of the column with stoppers. 276 
 277 
5.7) Incubate the mixture at 4 °C on a rotator at low speed for 2 h. 278 
 279 
5.8) Wash the fusion protein bound resin with 15 bed volumes of the binding buffer at 4 °C at a 280 
flow rate of 1 mL/min before elution. 281 
 282 
5.9) Add 500 μL of elution buffer (containing 20 mM Tris-Cl (pH 7.9), 500 mM imidazole, 0.5 M 283 
NaCl) to the column and incubate the slurry at 4 °C on a rotator at a low speed for 10 min. 284 
Collect the eluent as purified protein samples. 285 
 286 
5.10) Repeat Step 5.5 four more times. 287 
 288 
5.11) Wash the resin sequentially with 10 bed volumes of deionized water and 3 bed volumes 289 
of 20% ethanol. Soak the resin in 20% ethanol. Block the column with stoppers and store it at 290 
4 °C. 291 
 292 
5.12) Measure the concentration of the purified proteins by the Bradford protein assay. 293 
Determine the purity of the proteins on a 10% SDS-PAGE gel and visualize the bands by the 294 
Coomassie blue staining assay. 295 
 296 
5.13) Add glycerol to the purified protein solution to a final concentration of 10% to stabilize 297 
the enzyme activity. Aliquot and store it at -80 °C. 298 
 299 
6. Produce a flavonol from a flavanone in an in vitro bienzyme synthetic system16 300 
 301 
6.1) Prepare buffers. 302 
 303 
6.1.1) Make 2x synthetic buffer without ferrous sulfate consisting of 200 mM Tris-HCl (pH 7.2), 304 
16.4 mM α-ketoglutaric acid, 0.8% sodium ascorbate, and 20% glycerol. Dissolve 0.969 g of Tris 305 
base, 0.320 g of sodium ascorbate, 0.125 g of α-ketoglutaric acid, and 8 mL of glycerol to 32 mL 306 
of deionized water. Adjust pH to 7.2 by hydrochloric acid (HCl) and add deionized water up to 307 
40 mL. Store the buffer at 4 °C for future use. 308 



   

Page 7 of 6  revised November 2017 
 

 309 
6.1.2) Make a 100x stock solution of 2 mM ferrous sulfate. Dissolve 55.6 mg of ferrous sulfate 310 
heptahydrate in 50 mL of deionized water, stir, and add water up to 100 mL. 311 
 312 
6.1.3) Make a stock solution of 25 mM flavonoid. Dissolve a flavonoid in methanol thoroughly 313 
and stored at -20 ° C. 314 
 315 
6.2) Set up a synthetic system to produce a flavonol from a flavanone. 316 
 317 
6.2.1) Prepare the synthetic system as shown in Table 6. 318 
 319 
[Place Table 6 here] 320 
 321 
6.2.2) Incubate the reaction at 40 °C in an open 2.0-mL tube at 600 rpm (in a shaking heat block) 322 
for 40 min. 323 
 324 
6.2.3) Terminate the reaction by adding 10 μL of acetic acid and 100 μL of ethyl acetate. 325 
 326 
6.2.4) Two hours later, transfer the organic phases to 1.5-mL tubes for drying in a vacuum 327 
freeze-drying system (see Table of Materials). 328 
 329 
7. Analyze the reaction products 330 
 331 
7.1) Thin layer chromatography (TLC) analysis. 332 
 333 
7.1.1) Redissolve the flavonoid powder from step 6.2.4 in 100 μL of methanol. Prepare 334 
authentic flavonoid samples with serial concentrations of 12.5, 25, 50, 100, and 200 ng/μL in 335 
methanol. Load 1 μL of the reaction samples and the authentic flavonoid samples onto 336 
polyamide 6 plates. 337 
 338 
7.1.2) Run the sample-loaded plates in a solvent system comprising chloroform/methanol/ethyl 339 
acetate/formic acid at a ratio of 5.0:1.5:1.0:0.5. 340 
 341 
7.1.3) Air dry the plates at room temperature. Spray the plates with 1% ethanolic solution of 342 
aluminum chloride (AlCl3), followed by air drying again at room temperature. 343 
 344 
7.1.4) Thirty minutes later, visualize the spots on the plates under a UV light at 254 nm and take 345 
images. 346 
 347 
7.1.5) Analyze the gray value of each spot on the images using an image processing software 348 
(e.g., ImageJ v1.51j8 in this protocol). 349 
 350 
7.1.5.1) Open the software ImageJ. Click File > Open to open the image to be analyzed. 351 
 352 
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7.1.5.2) Click the left most Rectangular Selection Tool in the ImageJ User Interface. Outline the 353 

region of interest (ROI) in the image with the mouse and press □1  to label the first ROI. 354 

 355 

7.1.5.3) Move the rectangular selection with the mouse right to the next ROI and press □2  to 356 

label the second ROI. 357 
 358 
7.1.5.4) Repeat the previous step to label all other ROIs. 359 
 360 

7.1.5.5) Press □3  to generate profile plots for all ROIs in a pop-up window.  361 

 362 
NOTE: At this time, the Straight Line Selection Tool in the ImageJ User Interface will be 363 
automatically activated. 364 
 365 
7.1.5.6) Use the Straight Line Selection Tool to draw base lines so as to define a closed area for 366 
each peak of interest. 367 
 368 
7.1.5.7) Activate the Wand Tool by clicking the corresponding icon in the ImageJ User Interface. 369 
Click inside the peak to display results for all peaks in a pop-up window. 370 
 371 
7.1.6) Make a TLC-based standard curve of the authentic flavonoid by plotting the gray values 372 
from step 7.1.5.7 against the corresponding flavonoid concentrations from step 7.1.1. Then, 373 
calculate the yield of the flavonoid of interest produced in this protocol according to the 374 
resulting formula. 375 
 376 
7.2) High performance liquid chromatography (HPLC) and liquid chromatography/mass 377 
spectrometry (LC/MS) analyses 378 
 379 
7.2.1) Pool 5 tubes of the flavonoid samples from step 6.2.4 and take out 300 μL for drying. 380 
Redissolve the powder in 160 μL of methanol. Prepare authentic flavonoid samples with serial 381 
concentrations of 20, 40, 60, 80, and 100 ng/μL in methanol. Process the samples sequentially 382 
through 0.45 μm and 0.22 μm filters. 383 
 384 
7.2.2) Load the samples into a HPLC/LC/MS system (see Table of Materials) and separate the 385 
samples at 30 °C using a C18 (4.6 × 150 mm; i.d., 5 μm) column. Elute the column at 1.0 mL/min 386 
by a gradient of 10 - 85% (v/v) acetonitrile (ACN) in water (0 - 10 min, 10 - 25% ACN; 10 - 35 387 
min, 25 - 50% ACN; 35 - 45 min, 50 - 85% ACN; 45 - 50 min, 85 - 10% ACN; 50 - 60 min, 10% ACN) 388 
and monitor the absorbance of the eluate from 200 to 800 nm. Perform the LC/MS analysis in a 389 
negative ion mode with a drying nitrogen flow of 10 L/min at 300 °C and a sheath gas flow of 7 390 
L/min at 250 °C and collect data using a built-in software (see Table of Materials). 391 
 392 
7.2.3) Extract single wavelength chromatographs to calculate the peak areas of reaction 393 
samples and authentic flavonoid compounds using a software (see Table of Materials). 394 
 395 
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7.2.3.1) Open the Qualitative Analysis program and click File > Open Data File. Select the file(s) 396 
to be analyzed in the Open Data File window and click Open to open the file(s). 397 
 398 
7.2.3.2) Right-click the mouse in the Chromatogram Results window and then the Extract 399 
Chromatograms in a pop-up menu. 400 
 401 
7.2.3.3) Open the Extract Chromatograms dialog box. In the Type list, click Other 402 
Chromatograms. In the Detector combo box, select DAD1. Then click OK to display the HPLC 403 
results in the Chromatogram Results window. 404 
 405 
7.2.3.4) Click the Manual Integration icon docked at the top of the Chromatogram Results 406 
window. Draw a base line for the peak required for manual integration analysis with the mouse. 407 
 408 
7.2.3.5) Click View > Integration Peak List to display the results. 409 
 410 
7.2.4) Make a HPLC-based standard curve of the authentic flavonoid by plotting the peak areas 411 
from step 7.2.3.5 against the corresponding flavonoid concentrations from step 7.2.1. Then, 412 
calculate the yield of the flavonoid of interest produced in this protocol according to the 413 
resulting formula. 414 
 415 
7.2.5) Analyze the MS data for the exact mass of flavonoid compounds using a software (see 416 
Table of Materials). 417 
 418 
7.2.5.1) Repeat steps 7.2.3.1 - 7.2.3.3. 419 
 420 
7.2.5.2) Click the Range Select icon on the Chromatogram Results toolbar. 421 
 422 
7.2.5.3) Select the peak of interest. Right-click the mouse in the selected range and click the 423 
Extract MS Spectrum in the pop-up menu to display the results in the MS Spectrum Results 424 
window. 425 
 426 
REPRESENTATIVE RESULTS: 427 
F3H and FLS1 are two important key enzymes in the conversion of a flavanone into a flavonol in 428 
plants as shown in Figure 1. To develop an in vitro biosynthetic system for producing a flavonol 429 
from a flavanone, Atf3h (GenBank accession no. NM_114983.3) and Atfls1 (GenBank accession 430 
no. NM_120951.3) genes were cloned from the seedlings of 4-week-old A. thaliana into a 431 
prokaryotic expression vector pET-32a(+). The recombinant plasmids were transformed into E. 432 
coli BL21(DE3) and the fusion proteins were expressed after IPTG induction, followed by 433 
purification using Ni-IDA agarose resins. As shown in Figure 2, the purified fusion proteins 434 
showed a high purity of over 95% on a 10% SDS-PAGE gel, which were pure enough for the 435 
establishment of an in vitro bienzymatic cascade. 436 
 437 
[Place Figure 1 here] 438 
 439 
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[Place Figure 2 here] 440 
 441 
To establish a bienzymatic cascade using the purified recombinant proteins, a synthetic system 442 
was prepared as shown in Table 6. To determine whether this system can be used for the 443 
conversion of a flavanone into a flavonol, NRN was added into the system, and the biosynthesis 444 
of KMF was detected by TLC and HPLC/LC/MS analyses. As shown in Figure 3A, there were two 445 
new spots emerged on a polyamide TLC plate. One spot showed a migration distance similar to 446 
that of dihydrokaempferol (DHK), and the other similar to that of KMF. Further analysis by HPLC 447 
and LC/MS demonstrated that the new chemicals showed a retention time of 11.91 min and 448 
20.16 min, respectively (Figure 3B) and a quasi-molecular ion peak [M−H]− at m/z 287.0500 and 449 
285.0500, respectively (Figure 3C), which were identical to those of DHK and KMF, respectively. 450 
The data indicate that KMF was produced from NRN in this system and the yield was as high as 451 
34.94 mg/L. 452 
 453 
[Place Figure 3 here] 454 
 455 
To further determine whether this in vitro system can be used for the conversion of other 456 
flavanones into their corresponding flavonols, eriodictyol (ERD) was added into the system to 457 
determine whether ERD can be converted into quercetin (QRC). As shown in Figure 4A, two 458 
new spots on a polyamide TLC plate displayed a migration distance similar to that of 459 
dihydroquercetin (DHQ) and QRC, respectively. HPLC and LC/MS analyses demonstrated that 460 
these new chemicals revealed a retention time of 10.03 min and 16.23 min, respectively (Figure 461 
4B) and a quasi-molecular ion peak [M−H]− at m/z 303.1000 and 301.1000, respectively (Figure 462 
4C), which exactly corresponded to those of DHQ and QRC, respectively. The data indicate that 463 
this system can convert ERD into QRC and the yield was 25.55 mg/L. 464 
 465 
[Place Figure 4 here] 466 
 467 
FIGURE AND TABLE LEGENDS: 468 
 469 
Figure 1: Schematic representation for the biosynthesis of a flavonol from a flavanone in vitro. 470 
F3H, flavanone 3-hydroxylase; FLS1, flavonol synthase 1. 471 
 472 
Figure 2: Purification of recombinant AtF3H and AtFLS1 proteins. The Atf3h and Atfls1 genes 473 
were cloned from 4-week-old seedlings of Arabidopsis thaliana into a prokaryotic expression 474 
vector pET-32a(+) and expressed in Escherichia coli BL21(DE3). The recombinant proteins were 475 
purified through an affinity chromatography column filled with Ni-IDA agarose resins. The 476 
purity was determined on a 10% SDS-PAGE gel. M, protein markers; 1, recombinant AtF3H 477 
protein; 2, recombinant AtFLS1 protein. 478 
 479 
Figure 3: Synthesis of KMF from NRN in a bienzymatic cascade. (A) Analysis of the one-pot 480 
reaction products by polyamide TLC. 1, NRN standard; 2, DHK standard; 3, KMF standard; 4, 481 
reaction mixture. (B) HPLC analysis profiles of the reaction products. NRN, DHK, and KMF 482 
showed a retention time of 18.74 min, 11.91 min, and 20.16 min, respectively. (C) MS analysis 483 
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profiles of the flavonoid compounds in the reaction mixtures. 484 
 485 
Figure 4: Production of QRC from ERD in a bienzyme synthetic system. (A) Analysis of the 486 
reaction products by polyamide TLC. 1, ERD standard; 2, DHQ standard; 3, QRC standard; 4, 487 
reaction mixture. (B) HPLC analysis profiles of the reaction products. ERD, DHQ, and QRD 488 
displayed a retention time of 15.45 min, 10.03 min, and 16.23 min, respectively. (C) MS analysis 489 
profiles of the compounds in the reaction mixtures. 490 
 491 
Table 1: Reverse transcription of total RNA into cDNA 492 
 493 
Table 2: Oligonucleotide primers used in the current study 494 
 495 
Table 3: Setting up of a PCR reaction system 496 
 497 
Table 4: Double digestion of a DNA fragment/vector 498 
 499 
Table 5: Ligation of a gene fragment into a linearized vector 500 
 501 
Table 6: The synthetic system used in this protocol. 502 
 503 
DISCUSSION: 504 
Quite a number of studies are focused on the derivation of flavonols due to their potential 505 
application in health care and food industry. However, traditional plant extraction using organic 506 
solvents and chemical synthesis possess intrinsic disadvantages, which restrict their use in the 507 
production of flavonols. Here, we report a detailed method for producing a flavonol from a 508 
flavanone in one pot by establishing an in vitro bienzymatic cascade. The critical steps in this 509 
protocol are: 1) obtaining pure recombinant enzymes with high activities and 2) establishing a 510 
one-pot bienzymatic reaction cascade. Generally speaking, the expression of plant-derived 511 
genes in bacteria prefers to form inclusion body, which will lead to the loss of enzyme activity. 512 
As we know, some peptides, such as TrxA and SUMO, help to enhance the expression and 513 
solubility of recombinant proteins expressed in bacteria16. Therefore, it will be helpful to clone 514 
the target genes into the plasmids containing these expression tags, such as pET-32a(+) and pET 515 
SUMO (Step 3.2.3). It is well known that IPTG concentration and induction temperature are 516 
another two crucial parameters affecting the solubility of prokaryotically expressed proteins16. 517 
To further decrease the formation of inclusion body, IPTG concentration and induction 518 
temperature should be optimized. The optimum IPTG concentration and induction temperature 519 
mainly depends on the type of plasmids and the bacteria strains. In this protocol, the IPTG 520 
concentration and induction temperature are optimized at 0.2 mM and 20 - 22 °C, respectively 521 
(Step 4.2.3). In addition, temperature and glycerol are two important parameters for 522 
maintaining the stability and activity when purifying and storing the recombinant enzymes. In 523 
this protocol, it is crucial to purify the recombinant proteins at 4 °C (Steps 5.5 - 5.12), add 10% 524 
glycerol into the solution of purified enzymes (Step 5.13), and immediately aliquot and store 525 
the solution at -80 °C (Step 5.13). In establishment of a one-pot reaction cascade, pH and 526 
temperature are two vital parameters. It is obvious that too high pH is harmful for the 527 
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conversion because the ferrous ions (Fe2+), a necessary component for the enzyme activity of 528 
recombinant F3H and FLS116,32,33, are precipitated by forming a slurry of ferrous hydroxide 529 
under such a condition. Even though a relatively higher temperature facilitates the progress of 530 
an enzyme-catalyzed reaction, too high temperature will inactivate the enzyme. Therefore, it is 531 
critical for the conversion to stabilize the pH and reaction temperature. Our previous 532 
publication sets the optimum pH and temperature at 7.2 and 40 °C, respectively (Step 6)16. 533 
 534 
This protocol could be conveniently modified to biosynthesize a number of flavonols from 535 
various flavanones using different substrates. In this protocol, two examples are provided. As 536 
shown in Figure 3, when adding NRN as a substrate into this system, new chemicals were 537 
produced. TLC and HPLC/LC/MS analyses indicate that the new chemicals were DHK and KMF, 538 
and the NRN was converted into the KMF in this system. To further strengthen confidence in 539 
the results, spectral characterization of 1H NMR (hydrogen-1 nuclear magnetic resonance), 13C 540 
NMR (carbon-13 nuclear magnetic resonance), NOESY (Nuclear Overhauser Effect 541 
SpectroscopY), XRD (X-ray powder diffraction), CHN analyzer and the like may be required to 542 
attest the presence of chemicals in a new entity. Similarly, ERD could be successfully converted 543 
into QRC in this bienzymatic cascade (Figure 4). The yield of the KMF was higher than that of 544 
the QRC, indicating that the NRN is a better substance for this flavonol production system than 545 
the ERD. 546 
 547 
There is an important limitation for this method. According to the known biosynthetic pathway 548 
of flavonoids, a flavonol can be produced by this system from an aromatic amino acid or its 549 
downstream derivatives. For example, KMF can be produced from p-coumaric acid by a series 550 
of key enzymes, including 4-coumaroyl:CoA-ligase (4CL), chalcone synthase (CHS), chalcone 551 
isomerase (CHI), F3H and FLS23. Similarly, QRC can be produced from caffeic acid using the same 552 
panel of key enzymes (unpublished data). However, coenzyme A (CoA), ATP, and manonyl-CoA 553 
need to be included in the system to convert p-coumaric acid into KMF, which will greatly 554 
increase the production cost. Therefore, this system is usually restricted to convert a flavanone 555 
into a dihydroflavonol or a flavonol. In addition, complete conversion of starting materials is 556 
another challenge. To further improve the efficiency of this system, future research should be 557 
focused on screening key enzymes with high activities from other plants, mutation of genes 558 
encoding key enzymes, immobilization of the highly active enzymes to inert carriers, and 559 
development of a better buffer system. 560 
 561 
This one-pot bienzyme synthetic system possesses obvious intrinsic advantages over other 562 
approaches to produce a flavonol, such as chemical synthesis, microbial cell factory, and plant 563 
extraction using organic solvents16. Firstly, the reaction time is very short and needs only 40 min, 564 
so this production system is labor- and time-saving. Secondly, there is no complex physiological 565 
regulation in this system as occurred in the microbial cell factory and moreover, all components 566 
are clear. Therefore, it is easy to control the reaction accurately and thus convenient to make 567 
further optimization in the future. Thirdly, since this reaction system contains only simple 568 
chemicals and purified recombinant enzymes and only generates one major intermediate as 569 
shown in Figure 3 and Figure 4, it is expected that it is easier to purify the target molecules 570 
generated in this system than those from cell factories and plants. Fourthly, the major 571 
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components of the system are common and cheap chemicals and prokaryotically expressed 572 
recombinant enzymes, so it is highly cost-effective for this method to derive desired flavonoids. 573 
Fifthly, due to the simplicity of the components of this system, it is easy to scale up for mass 574 
production of target flavonoids, indicating a huge industrialization potential. In addition, this 575 
system provides a guide for the economical production of other secondary metabolites. 576 
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Reagents  Volume

dNTP Mix, 2.5mM each 4.0 μL

Primer Mix 2.0 μL

RNA Template 1.0 μg

Reverse Transcriptase Buffer, 5× 4.0 μL

Reverse Transcriptase, 200 U/μL 1.0 μL

RNase-Free H2O up to 20.0 μL

Table 1 Reverse transcription of total RNA into cDNA
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Sequence, 5' → 3' Purpose

AAGGATCC ATGGCTCCAGGAACTTTGA

CT

Forward primer for PCR amplification of Atf3h  gene from 

Arabidopsis thaliana.  Bam HI site is italicized and attached 

for cloning into pET32a(+).
AAGAATTC CTAAGCGAAGATTTGGTCG

A

Reverse primer for PCR amplification of Atf3h  gene from A. 

thaliana.  Eco RI site is italicized and attached for cloning 

into pET32a(+).
AAGGATCC ATGGAGGTCGAAAGAGTCC

A

Forward primer for PCR amplification of Atfls1  gene from 

A. thaliana.  Bam HI site is italicized and attached for cloning 

into pET32a(+).
AAGAATTC TCAATCCAGAGGAAGTTTAT Reverse primer for PCR amplification of Atfls1  gene from 

A. thaliana.  Eco RI site is italicized and attached for cloning 

into pET32a(+).

Table 2 Oligonucleotide primers used in the current study
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Reagents Volume

Pfu Master Mix, 2× 50.0 μL

Forward Primer, 10 μM 4.0 μL

Reverse Primer, 10 μM 4.0 μL

cDNA 2.0 μL

H2O 40.0 μL

Table 3 Setting up of a PCR reaction system
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Reagents Volume

DNA Fragment/Vector 3.0 μg

Bam HI 1.0 μL

Eco RI 1.0 μL

Cutsmart Buffer, 10× 5.0 μL

H2O up to 50.0 μL

Table 4 Double digestion of a DNA fragment/vector
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Reagents Volume

Insert X μL (0.09 pmol)

Vector Y μL (0.03 pmol)

Ligation Buffer, 10× 1.0 μL

T4 DNA Ligase, 400 U/μL 1.0 μL

H2O up to 10.0 μL

Table 5 Ligation of a gene fragment into a linearized vector
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Reagents  Volume
2× Synthetic Buffer without ferrous 

sulfate 50.0 μL

25 mM flavonol 2.0 μL

2 mM ferrous sulfate 0.5 μL

1 mg/mL AtF3H 2.5 μL

1 mg/mL AtFLS1 2.5 μL

25 mM flavanone 2.0 μL

H2O up to 100.0 μL

Table 6 Setting up of an in vitro synthetic system for the 

production of a flavonol from a flavanone
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Name of Material/ Equipment Company Catalog 

Number

Comments/Description

2× Pfu MasterMix Beijing CoWin Biotech Co., Ltd CW0717A PCR amplification of genes with high 

fidelity 
Agilent 1200 Series RRLC system 

with an Agilent 6460 Triple 

Quadrupole LC/MS system

Agilent Technologies, Inc N/A an equipment for analysis of 

flavonoids by HPLC/MS

Agilent MassHunter Workstation 

(version B.03.01)

Agilent Technologies, Inc N/A a software for collection of the data 

from the Agilent 1200 Series RRLC 

system with an Agilent 6460 Triple 

Quadrupole LC/MS system
dihydrokaempferol Sigma-Aldrich Co. LLC 91216 intermediate product for producing 

kaempferol from naringenin
dihydroquercetin Sichuan Provincial Standard 

Substance Center for Chinese 

Herbal Medicine

PCS0371 intermediate product for producing 

quercetin from eriodictyol

DNA Clean-up Kit Beijing CoWin Biotech Co., Ltd CW2301 purification of PCR-amplified or gel-

purified DNA
eriodictyol Shanghai Yuan Ye 

Biotechnology Co., Ltd.

B21160 substrate for producing quercetin

Escherichia coli  BL21(DE3) Beijing CoWin Biotech Co., Ltd CW0809 bacteria strain for expressing target 

genes
Escherichia coli  DH5α Beijing CoWin Biotech Co., Ltd CW0808 bacteria strain for plasmid 

proliferation
FreeZone 1 Liter Benchtop Freeze-

Dry System

Labconco Corporation 7740020 an equipment for freeze-drying of 

flavonoids dissolved in organic solvent

Gel Extraction Kit Beijing CoWin Biotech Co., Ltd CW2302 purification of a DNA band from an 

agarose gel
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Gel Imaging System Shanghai Tanon Science & 

Technology Co. Ltd.

Tanon-

2500

an equipment for visualization of DNA 

band on an agarose gel or flavonoid 

spot on a polyamide TLC plate

GenElute Plasmid Miniprep Kit Sigma-Aldrich Co. LLC PLN350-1KT minipreparation of plasmids

kaempferol Sigma-Aldrich Co. LLC 60010 final reaction product and standard 

substance
MassHunter Quanlitative Analysis 

(version B.01.04)

Agilent Technologies, Inc N/A a software for  analysis of HPLC/LC/MS 

data
NanoDrop Microvolume UV-Vis 

Spectrophotometer

Thermo Fisher Scientific ND-8000-GL an equipment for  determination of 

DNA/RNA concentration
naringenin Sigma-Aldrich Co. LLC N5893 substrate for producing kaempferol

Ni-IDA Agarose Resin Beijing CoWin Biotech Co., Ltd CW0010 purification of His-tagged fusion 

proteins
pET-32a(+) Novagen 69015-3 plasmid for cloning and expressing 

target genes
plasmid sequencing GENEWIZ Suzhou N/A sequencing of recombinant plasmids

primer synthesis GENEWIZ Suzhou N/A synthesis of PCR primers

quercetin Shanghai Aladdin Biochemical 

Technology Co.,Ltd.

Q111273 final reaction product and standard 

substance

SuperRT cDNA Synthesis Kit Beijing CoWin Biotech Co., Ltd CW0741 synthesis of the first strand of cDNA 

from total RNA
T4 DNA Ligase Thermo Fisher Scientific EL0016 ligation of an insert into a linearized 

vector DNA
Trizol Thermo Fisher Scientific 15596018 isolation of total RNA

Vector NTI Advance Thermo Fisher Scientific 12605099 a software for PCR primer design and 

DNA sequence analysis
Xcalibur v2.0.7 Thermo Fisher Scientific N/A a software for analysis of HPLC data
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“Video” means any video(s) made by the Author, alone or 
in conjunction with any other parties, or by JoVE or its 
affiliates or agents, individually or in collaboration with the 
Author or any other parties, incorporating all or any portion 

of the Article, and in which the Author may or may not 
appear. 
2. Background. The Author, who is the author of the 
Article, in order to ensure the dissemination and protection 
of the Article, desires to have the JoVE publish the Article 
and create and transmit videos based on the Article. In 
furtherance of such goals, the Parties desire to memorialize 
in this Agreement the respective rights of each Party in and 
to the Article and the Video. 
3. Grant of Rights in Article. In consideration of JoVE 
agreeing to publish the Article, the Author hereby grants to 
JoVE, subject to Sections 4 and 7 below, the exclusive, 
royalty-free, perpetual (for the full term of copyright in the 
Article, including any extensions thereto) license (a) to 
publish, reproduce, distribute, display and store the Article 
in all forms, formats and media whether now known or 
hereafter developed (including without limitation in print, 
digital and electronic form) throughout the world, (b) to 
translate the Article into other languages, create 
adaptations, summaries or extracts of the Article or other 
Derivative Works (including, without limitation, the Video) 
or Collective Works based on all or any portion of the Article 
and exercise all of the rights set forth in (a) above in such 
translations, adaptations, summaries, extracts, Derivative 
Works or Collective Works and(c) to license others to do any 
or all of the above. The foregoing rights may be exercised in 
all media and formats, whether now known or hereafter 
devised, and include the right to make such modifications 
as are technically necessary to exercise the rights in other 
media and formats. If the “Open Access” box has been 
checked in Item 1 above, JoVE and the Author hereby grant 
to the public all such rights in the Article as provided in, but 
subject to all limitations and requirements set forth in, the 
CRC License. 
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4. Retention of Rights in Article. Notwithstanding 
the exclusive license granted to JoVE in Section 3 above, the 
Author shall, with respect to the Article, retain the non-
exclusive right to use all or part of the Article for the non-
commercial purpose of giving lectures, presentations or 
teaching classes, and to post a copy of the Article on the 
Institution’s website or the Author’s personal website, in 
each case provided that a link to the Article on the JoVE 
website is provided and notice of JoVE’s copyright in the 
Article is included. All non-copyright intellectual property 
rights in and to the Article, such as patent rights, shall 
remain with the Author. 
5. Grant of Rights in Video – Standard Access. This 
Section 5 applies if the “Standard Access” box has been 
checked in Item 1 above or if no box has been checked in 
Item 1 above. In consideration of JoVE agreeing to produce, 
display or otherwise assist with the Video, the Author 
hereby acknowledges and agrees that, Subject to Section 7 
below, JoVE is and shall be the sole and exclusive owner of 
all rights of any nature, including, without limitation, all 
copyrights, in and to the Video. To the extent that, by law, 
the Author is deemed, now or at any time in the future, to 
have any rights of any nature in or to the Video, the Author 
hereby disclaims all such rights and transfers all such rights 
to JoVE. 
6. Grant of Rights in Video – Open Access. This 
Section 6 applies only if the “Open Access” box has been 
checked in Item 1 above. In consideration of JoVE agreeing 
to produce, display or otherwise assist with the Video, the 
Author hereby grants to JoVE, subject to Section 7 below, 
the exclusive, royalty-free, perpetual (for the full term of 
copyright in the Article, including any extensions thereto) 
license (a) to publish, reproduce, distribute, display and 
store the Video in all forms, formats and media whether 
now known or hereafter developed (including without 
limitation in print, digital and electronic form) throughout 
the world, (b) to translate the Video into other languages, 
create adaptations, summaries or extracts of the Video or 
other Derivative Works or Collective Works based on all or 
any portion of the Video and exercise all of the rights set 
forth in (a) above in such translations, adaptations, 
summaries, extracts, Derivative Works or Collective Works 
and (c) to license others to do any or all of the above. The 
foregoing rights may be exercised in all media and formats, 
whether now known or hereafter devised, and include the 
right to make such modifications as are technically 
necessary to exercise the rights in other media and formats. 
For any Video to which this Section 6 is applicable, JoVE and 
the Author hereby grant to the public all such rights in the 
Video as provided in, but subject to all limitations and 
requirements set forth in, the CRC License. 
7. Government Employees. If the Author is a United 
States government employee and the Article was prepared 
in the course of his or her duties as a United States 
government employee, as indicated in Item 2 above, and 
any of the licenses or grants granted by the Author 
hereunder exceed the scope of the 17 U.S.C. 403, then the 
rights granted hereunder shall be limited to the maximum 

rights permitted under such statute. In such case, all 
provisions contained herein that are not in conflict with 
such statute shall remain in full force and effect, and all 
provisions contained herein that do so conflict shall be 
deemed to be amended so as to provide to JoVE the 
maximum rights permissible within such statute. 
8. Protection of the Work. The Author(s) authorize 
JoVE to take steps in the Author(s) name and on their behalf 
if JoVE believes some third party could be infringing or 
might infringe the copyright of either the Author’s Article 
and/or Video. 
9. Likeness, Privacy, Personality. The Author hereby 
grants JoVE the right to use the Author’s name, voice, 
likeness, picture, photograph, image, biography and 
performance in any way, commercial or otherwise, in 
connection with the Materials and the sale, promotion and 
distribution thereof. The Author hereby waives any and all 
rights he or she may have, relating to his or her appearance 
in the Video or otherwise relating to the Materials, under 
all applicable privacy, likeness, personality or similar laws. 
10. Author Warranties. The Author represents and 
warrants that the Article is original, that it has not been 
published, that the copyright interest is owned by the 
Author (or, if more than one author is listed at the beginning 
of this Agreement, by such authors collectively) and has not 
been assigned, licensed, or otherwise transferred to any 
other party. The Author represents and warrants that the 
author(s) listed at the top of this Agreement are the only 
authors of the Materials. If more than one author is listed 
at the top of this Agreement and if any such author has not 
entered into a separate Article and Video License 
Agreement with JoVE relating to the Materials, the Author 
represents and warrants that the Author has been 
authorized by each of the other such authors to execute this 
Agreement on his or her behalf and to bind him or her with 
respect to the terms of this Agreement as if each of them 
had been a party hereto as an Author. The Author warrants 
that the use, reproduction, distribution, public or private 
performance or display, and/or modification of all or any 
portion of the Materials does not and will not violate, 
infringe and/or misappropriate the patent, trademark, 
intellectual property or other rights of any third party. The 
Author represents and warrants that it has and will 
continue to comply with all government, institutional and 
other regulations, including, without limitation all 
institutional, laboratory, hospital, ethical, human and 
animal treatment, privacy, and all other rules, regulations, 
laws, procedures or guidelines, applicable to the Materials, 
and that all research involving human and animal subjects 
has been approved by the Author's relevant institutional 
review board. 
11. JoVE Discretion. If the Author requests the 
assistance of JoVE in producing the Video in the Author’s 
facility, the Author shall ensure that the presence of JoVE 
employees, agents or independent contractors is in 
accordance with the relevant regulations of the Author's 
institution. If more than one author is listed at the 
beginning of this Agreement, JoVE may, in its sole 





Dear Editor, 

 

Thanks for your interest in our manuscript. Followed are our responses to all editorial and 

reviewers’ comments. 

 

Editorial comments: 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are 

no spelling or grammar issues. 

Our response: We have thoroughly proofread the manuscript. 

 

2. Please revise the title to be more concise. For instance, “A method for the” may be deleted. 

Our response: We have revised the title as you suggested. 

 

3. Please provide an institutional email address, if possible, for each author. 

Our response: Yes, we have provided an institutional email address for each author. 

 

4. JoVE cannot publish manuscripts containing commercial language. This includes trademark 

symbols (™), registered symbols (®), and company names before an instrument or reagent. Please 

remove all commercial language from your manuscript and use generic terms instead. All 

commercial products should be sufficiently referenced in the Table of Materials and Reagents. 

You may use the generic term followed by “(see table of materials)” to draw the readers’ 

attention to specific commercial names. Examples of commercial sounding language in your 

manuscript are: Trizol, NanoDrop, Thermo Scientific, Beijing CoWin Biotech Co., Ltd., Vector NTI 

Advance, GENEWIZ, Vazyme Biotech Co., Ltd, GenElute, Sigma-Aldrich Co. LLC, Agilent, Labconco, 

etc. 

Our response: We have replaced all commercial language with generic terms. 

 

5. Please add more details to your protocol steps. There should be enough detail in each step to 

supplement the actions seen in the video so that viewers can easily replicate the protocol. Please 

ensure you answer the “how” question, i.e., how is the step performed? Alternatively, add 

references to published material specifying how to perform the protocol action. See examples 

below. 

Our response: We have added enough details to all protocol steps and added related references 

to published materials. 

 

6. For PCR, please specify PCR primers and conditions throughout the protocol. 

Our response: The PCR primers are specified in step 3.1.1 and Table 2. The PCR conditions are 

specified in step 3.2.1. 

 

7. 3.1: Please note that the design step 3.1.1 is not appropriate for filming. 

Our response: The step 3.1.1 is rewritten and also excluded from filming in the revision. 

 

8. 3.2.1-3.2.4: if these steps are included for filming, specific details about how to perform these 

steps are required. Referring to the manufacturer's manual only is not sufficient. 

Rebuttal Letter Click here to access/download;Rebuttal Letter;Rebuttal Letter
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Our response: We rewrite 3.2.1-3.2.4, but don’t plan to film this part because it is a routine 

experiment. 

 

9. 6.2.4: Are the organic phases frozen before drying in a freeze dryer? 

Our response: No. 

 

10. 7.1.1: Please provide some guidance on the appropriate volume of methanol. 

Our response: We rewrite this part in the revision. 

 

11. 7.1.4: Please describe how to analyze the gray value using ImageJ. 

Our response: We have described it in details in step 7.1.5 in the revision. 

 

12. 7.1.5, 7.2.3: Please describe how. Software steps must be more explicitly explained ('click', 

'select', etc.). Please add more specific details (e.g. button clicks for software actions, numerical 

values for settings, etc.). 

Our response: We have described these two parts in details in the revision. 

 

13. After you have made all the recommended changes to your protocol (listed above), please 

highlight 2.75 pages or less of the Protocol (including headings and spacing) that identifies the 

essential steps of the protocol for the video, i.e., the steps that should be visualized to tell the 

most cohesive story of the Protocol. 

Our response: Yea, we did it. 

 

14. Please highlight complete sentences (not parts of sentences). Please ensure that the 

highlighted part of the step includes at least one action that is written in imperative tense. 

Our response: Yes, we have highlighted all complete sentences critical for filming. 

 

15. Please include all relevant details that are required to perform the step in the highlighting. For 

example: If step 2.5 is highlighted for filming and the details of how to perform the step are given 

in steps 2.5.1 and 2.5.2, then the sub-steps where the details are provided must be highlighted. 

Our response: Yes, we did so. 

 

16. Figure 3A and Figure 4A: Please mark the fragment sizes. 

Our response: These figures are TLC results and we indicate the identity of the dots in the image. 

 

17. References: Please do not abbreviate journal titles. 

Our response: We have corrected all abbreviated journal titles. 

 

18. Table of Materials: Please sort the items in alphabetical order according to the name of 

material/equipment. 

Our response: We sorted the items in alphabetical order according to the name of 

material/equipment. 

 

Reviewers' comments: 



Reviewer #1: 

1. Though it is mentioned in the "Discussion part" as "TLC and HPLC-MS analyses indicate that the 

new chemicals were DHK and KMF", may I add my opinion in this regard as "Spectral 

characterization of 1HNMR, 13CNMR, NOESY, XRD, CHN analysis and the like many required to 

attest the presence of chemicals in a new entity". Though not all, may I suggest as few can be 

studied to characterize new entity chemicals. 

Our response: We have added this sentence in the second paragraph of the Discussion part 

(Lines 535-539). 

 

2. In the Protocol, say in the procedures of all seven topics, viz., i) Isolation RNA ii) Synthesizing 

CDNA and so on ------- to vii) Analyze the reaction products, May I Know a fact that all steps 

written in all seven procedures are authors' if not, then, no references being mentioned 

anywhere in all seven steps of protocol. 

Our response: Actually, we write the procedures of all seven procedures. In the revision, we cited 

the related publications. 

 

3. From the scheme, it is clear that flavonol is being produced from flavanone, but many in other 

paras like in introduction part or in representative results or in Discussion, then and there, 

somewhere, it was found to be written as though flavanone being produced from flavanol. 

Our response: We correct the typo. 

 

Reviewer #2: 

Manuscript Summary: 

A method for the in vitro enzymatic synthesis of flavonol was developed, and two enzymes were 

expressed by the corresponding Atf3h and Atfls1 genes and used to catalyze the synthesis of 

flavonol in vitro. The method displays obvious advantages for synthesis of natural products. 

However, in this work some problems remained unclear and indistinct such as something in 

Figure 1. In the second part, DHK and DHQ were catalyzed to form the KMF and QRC by 

dehydrogenation, respectively. In this reaction, where is the hydrogen acceptor? In addition, the 

paper was not carefully prepared and there were many mistakes in the manuscript. In the 

Reference, the names of authors were not listed completely consistent according to the 

requirements of JoVE. Some headlines were given as verb phrase such as that in page 2. 

Our response: Figure 1 was a simplified schematic representation and only key substrate was 

shown. In the revision, we have modified Figure 1 with more details showing that the hydrogen 

acceptor is O2. In addition, we have carefully revised the manuscript and corrected all mistakes 

we can find including that in the Reference part. 

 

Reviewer #3: 

There is no question required to address. 

 

Reviewer #4: 

1. 7.1.1) Redissolve the flavonoid powder from step 6.2.4 in an appropriate volume of methanol." 

It should be more precisely described. 

Our response: We describe it more precisely in the revision. 



 

2. 7.2.2). " Elute the column at 1.0 mL/min by a 10-85% (v/v) gradient of acetonitrile in water 

(0-10 min, a linear gradient of 10-25% (v/v) B; 10-35 min, a linear gradient of 25-50% B in 75-50% 

A; 35-45 min, a linear gradient of 50-85% B in 50-15% A; 45-50 min, a linear gradient of 85-10% B 

in 15-90% A; 50-60 min, 10% B in 95% A) and monitor the absorbance of the eluate from 200 to 

800 nm." The description of gradient program of the mobile phase based on the reporting the 

changes of B component are enough. It should be corrected to the form presented above. 

Our response: We have corrected the description of the gradient program in step 7.2.2. 

 

3. References. The abbreviations of the names of journals in positions 2 and13 should be used. 

Our response: We have corrected all errors in the Reference part. 

 

4. Minor editorial mistake. 

In the manuscript there are some editorial mistakes such as e.g. 

Page 2 line 143: 20μL 

Page 5 line 236: (pH8.0) 

Page 5 line 249: pH7.9), 

Page 5 line 260: (pH7.9), 

Page 6 line 287: FeSO4·7H2O 

Our response: We correct all these mistakes in the revision. 

 

Reviewer #5: 

Major Concerns: 

Yield and purity Calculations. HPLC standard curve is not discussed in results. Side products and 

complete conversion of starting material. 

Our response: We describe the calculation of the yield and the HPLC standard curve in details in 

the revision. We also discuss the side products and complete conversion of starting material in 

the Discussion part of the revision. But, we do not mention purity calculation because this 

protocol is focused on generation of a system for production of a flavonol from a flavanone, not 

for purification of a flavonol. 

 

We are looking forward to hearing further information from you. 

 

Sincerely yours, 

 

Xinyue Zhang 

PhD, Professor 

College of Bioscience and Biotechnology, 

Yangzhou University, 

Yangzhou, Jiangsu 225009, PR China 

Tel: +86-514-8799-3623. 

E-mail: zhangxinyue@yzu.edu.cn, xyzhang_1@163.com 
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